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1. Introduction 

1.1 Welcome 
ZebraDesigner is a family of professional labeling software products that 
brings a complete bar code printing solution and RFID Smart Label printing to 
desktop users. ZebraDesigner offers an easy-to-use interface and meets any 
label design and printing requirement for efficient label printing solutions for 
users in retail, logistics, health care, chemical, automotive and other 
industries. 

ZebraDesigner can be used with any 32-bit Windows operating system: 
Windows 98 SE, Windows NT 4.0, Windows ME, Windows 2000, Windows 
XP and Windows Server 2003.  

The latest software version is available as a free download on the Zebra Web 
site at www.zebra.com. 

1.2 ZebraDesigner Pro Software Package 
Before you start installing ZebraDesigner Pro, check the contents of the 
package to ensure it is complete. The package must include: 

- ZebraDesigner Pro CD 

- Registration number on a label (not available with all editions) 

Please contact your software vendor if your package is missing any of the 
items listed. 

1.3 About this Manual 
The ZebraDesigner Pro Quick Start Guide helps you design and print labels 
quickly. The ZebraDesigner Quick Start Guide is an excerpt of the complete 
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ZebraDesigner Pro User Guide that you can obtain on the ZebraDesigner Pro 
CD or online at www.zebra.com. 

1.3.1 Typographical Conventions 

• Text that appears in bold refers to menu names, file names 
(SETUP.EXE), and buttons (OK). When there is a flow of menu 
selections they appear with a > separating the different menu choices. 
For example, Start > Programs > ZebraDesigner Pro.  

• Text that appears in italic refers to confirming actions like Read only 
and locations such as Folder. 

• Text that appears in bold Arial refers to keys from the desktop PC 
keyboard.  For example Enter. 

• Variables are enclosed in []. For example [variable]. 

• Text that needs to be typed in appears in italic. Or example, type the 
word SAMPLE.  

1.3.2 Software Restrictions 

All features explained in the Quick Start Guide are available in the 
ZebraDesigner Pro edition, but some features are not available in the 
ZebraDesigner edition. Sections discussing features not available with 
ZebraDesigner displays an alert icon, as follows: 

This icon identifies features that are available only in ZebraDesigner Pro. 
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2. Installation and Activation 

2.1 System and Software Requirements 
To run ZebraDesigner you need at least the following: 

• Pentium-based computer with at least 64 MB of RAM. 

• One of these 32-bit Windows operating systems: Microsoft 
Windows 98 SE, ME, NT, 2000, XP, or 2003. 

• Hard disk with 50 to 205 MB of free disk space (depending on the 
installation options). 

• CD-ROM drive. 

• Support for OLE DB database drivers. Recent Windows operating 
systems have included OLE DB database drivers. If your operation 
system does not have the database support, the installation wizard 
prompts you to install it. 

• Administrator rights to the local computer during installation. 

2.2 Installing ZebraDesigner Pro 
When you put the ZebraDesigner Pro CD in your CD-ROM drive, the 
installation/demonstration program automatically starts. You can browse the 
directory of the CD and look at the brochures, technical documentation, 
sample files, and other documents.  

Note:  If you are using Windows NT, 2000, XP, or 2003, you have to log 
on with Administrator rights to be able to perform installation. 
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2.2.1 Close all Software Applications 

To ensure complete installation of ZebraDesigner Pro , close all open software 
applications before you start installing ZebraDesigner Pro. 

2.2.2 Run Installation 

Use the installation wizard to install ZebraDesigner Pro on your desktop PC.  

To install the software, do the following: 

1. Put the ZebraDesigner Pro CD in your CD-ROM drive. An installation 
window automatically opens. 

Note: If the installation wizard does not start automatically, go to the main 
CD directory of your ZebraDesigner Pro CD and double-click the 
file START.EXE. 

2. Click Install. A new window opens showing all ZebraDesigner editions.  

3. Click on the version of ZebraDesigner that you want to install, and follow 
the prompts. 

2.2.3 Define Setup Options 

To continue installation, do the following: 

1. Click the Next button. 

2. Specify the program group you want to use for ZebraDesigner Pro. 

3. Specify if shortcuts to ZebraDesigner Pro should be created on the desktop 
or in the Quick Launch area. 

4. To finish installation, click the Install button. 

5. After installation you will be asked to install a printer driver. It is necessary 
to install a ZebraDesigner driver. If you do not install a printer driver while 
installing the software, you will be asked to install one the first time you 
run the program.  
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6. Once the installation is complete, the Start menu in Windows shows a new 
program group for ZebraDesigner Pro that contains shortcuts for all 
ZebraDesigner Pro applications. 

2.2.4 Install Printer Driver 

To install the ZebraDesigner printer driver on your computer, do the 
following: 

1. Click Start > Programs > ZebraDesigner Pro. 

2. In the group ZebraDesigner Pro, click the shortcut Add printer. 

3. The printer installation wizard starts. 

4. Follow the on-screen instructions. 

2.3 Registering ZebraDesigner Pro 
Activate ZebraDesigner Pro to obtain all features. If you do not complete the 
activation process, ZebraDesigner Pro only runs in DEMO mode. 

Note: ZebraDesigner does not require registration. It is free software, but 
available with less functionality than ZebraDesigner Pro. 

To register the software, do the following: 

1. Start ZebraDesigner Pro. 
The DEMO dialog box appears. 

2. Click the Register button. 

3. Enter the required information and follow the prompts. 

2.4 ZebraDesigner Pro DEMO Mode 
ZebraDesigner Pro running in the DEMO mode has limited functionality. The 
major limitations of the ZebraDesigner Pro DEMO mode are: 

• All "e" characters in the text objects are replaced by "Z" characters. 

• Graphic images are printed with DEMO text written over them. 
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You should use the DEMO version only to evaluate the software. Any 
commercial use of the DEMO software is prohibited. To obtain the full 
working version of ZebraDesigner Pro, you must purchase and register the 
software. 

2.5 Installing ZebraDesigner Pro Upgrades 
You can upgrade ZebraDesigner Pro as follows:  

• Upgrade from an older version to the most current one. 

• Upgrade from one edition, for example ZebraDesigner, to a more 
advanced edition, for example ZebraDesigner Pro. 

2.5.1 Install ZebraDesigner Pro Version Upgrade 

In a ZebraDesigner Pro software version upgrade, you upgrade the older 
version to the newer version. Before you upgrade ZebraDesigner, make sure 
you: 

• Backup the old ZebraDesigner Pro label (.lbl) files. 

• Do not remove the existing version from your desktop PC. 

• Check what ZebraDesigner edition you have. 

Note: To check your ZebraDesigner edition, look at the label on your CD, 
or open ZebraDesigner and go to Help/About in the menu. 

To upgrade ZebraDesigner, do the following: 

1. Close the ZebraDesigner software on your desktop PC. 

2. Put the ZebraDesigner CD in your CD-ROM drive. 

3. Install the new version in the same folder where the old version is 
currently installed. The new version replaces the old one. 

4. Follow the prompts. 



 Chapter 2: Installation and Activation 

 

 

ZebraDesigner Pro Quick Start Guide 9 

2.5.2 Install ZebraDesigner Edition Upgrade 

When you perform an edition upgrade, you want to upgrade to a more 
powerful ZebraDesigner edition; for example, upgrade from ZebraDesigner to 
ZebraDesigner Pro. 

To upgrade your ZebraDesigner edition, do the following: 

1. Remove the existing edition of ZebraDesigner software.  

2. Open Add or Remove Programs from Control Panel, select 
ZebraDesigner from the list and click the Remove button. 
During the removal of the old edition, all user files (labels and forms) 
remain on the hard drive in the My Documents folder and be accessible 
in the new edition. 

3. Install the new edition on your computer. Follow the same instructions 
as for first-time installation. Refer to the chapter Installing Software in 
the ZebraDesigner Pro User Guide. 
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3. Label Design and Printing 

In this chapter you will learn how to design and print labels with 
ZebraDesigner Pro. All examples assume that you are using a thermal printer 
and a ZebraDesigner printer driver. 

The screenshots in this chapter show the default view on the ZebraDesigner 
Pro interface. You can change the interface according to your preferences. 

To start designing a label, open ZebraDesigner Pro. The figure below shows 
the default working interface of ZebraDesigner Pro. 

 
ZebraDesigner Pro working window 
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3.1 Designing a Basic Label 
In this section you learn how to design a simple label file with fixed and 
variable objects. The variable objects can obtain values from several sources. 
You learn how to: 

a. Provide object values with a keyboard prompt. 

b. Obtain object values from a database.  

c. Preview the label on the screen. 

d. Print the label. 

The label you create looks like this: 

 
Basic label 

3.1.1 Create a Basic Label 

To create a basic label, do the following: 

1. Open ZebraDesigner Pro. 

2. Select New in the File menu, or click the  button in the Standard 
toolbar. 
Each time you create a new label, a Label Setup Wizard starts to help 
you set up the label and connect to the printer. 
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Selecting label layout 

Note: You can leave the Wizard at any time and accept the default settings 
for the label by clicking on the Finish button. 

Select a Printer 

1. Select the printer you want to use for label printing. 

Note: If you don’t find your printer on the list, refer to chapter Install 
Printer Driver for installation instructions. 

2. Click the Next button.  

Define Label and Page Dimensions  

1. If you want to use the label stock, select your choices in the Label Setup 
Wizard -  Select Stock window.  
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2. Click the Next button. A new window opens to define the label 
dimensions manually. 

3. Leave the option Page Size on 'User defined' default and check 
Automatic Sizing.  

4. Click the Next button. A new window opens. 

5. Select label orientation and print direction.  

 
Selecting label layout 

6. Click the Next button. A new window opens. 

7. Type 10 for label width and 7 for label height. 
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Defining label dimensions 

Note: To change the unit of measure from centimeters to inches or other 
supported units, click the button with unit of measure below the 
label preview in the dialog box. 

8. Click the Finish button. A new empty label opens. 

Enter Non-Changing Text 

1. Click the  button in the Toolbox. The text cursor appears 
on the screen. 

 
Cursor for text object 
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2. Move the cursor to the location on the label where you want to place the 
text object and click the mouse.  

The dialog box with object properties opens. 

3. Type SAMPLE and click the Finish button. 

 
Entering content for text object 

4. To select the object, click the text object. 

5. Change the font for the text object using the Text toolbar. 

Choose Arial font, 28 point size and bold style. 

 
Using format options in the text toolbox 
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6. To change the position and size of the text object, select the text object 
and drag it with your mouse to the new position. 
The screen should show the following: 

 
The text object is placed on the label 

Insert Bar Code 

Now you will add a non-changeable Code 128 bar code on the label. 

1. To insert the bar code, click the  button in the Toolbox. 

2. Move the cursor to the desired position on the label and click the mouse 
button.  
The dialog box with object properties opens. 

3. Type the value 1234567890 for the bar code contents. 

4. Click the Define button. 
The Edit Bar Code dialog box opens. 

5. Select bar code Code 128 and click the OK button. 
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Selecting bar code type 

6. Click the Finish button to return to the label. 

7. Change the position of the bar code by selecting the bar code and 
dragging it to the desired position. 

8. Change the object size by dragging the object handles. The handles are 
small rectangles surrounding the object when it is selected. 
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The label should now show the following: 

 
Label with text and bar code objects 

Insert Picture 

ZebraDesigner Pro works with BMP, PCX, GIF, WMF, JPEG, and many 
other popular graphic formats. 

1. To insert the picture, click the  button in the Toolbox. 

2. Move the cursor to the desired position on the label and click the mouse 
button. 

3. The Open dialog box opens, allowing you to browse for your picture on 
your hard drive.  

4. Go to the folder Sample Graphics and select the picture 
LEISURE.WMF.  

5. Click the Open button. 
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The screen should show the following: 

 
Label with text, bar code and picture objects 

Use Drawing Tools 

Now you will insert a line to separate a text object from other objects, and 
then insert a rectangle around the picture object. 

1. Select the  button from Toolbox and move the cursor to 
the required starting point of the line. 

2. Press and hold down the mouse button while drawing the line. Move the 
mouse to the end position of the line and release the button.  
The Line object is placed on the label. 

3. Click the  button in the Toolbox and point the mouse to 
the upper left corner of the picture. 

4. Click and hold the mouse button while you stretch the rectangle to the 
lower right corner of the picture. 

5. To change the thickness of the vertical and horizontal line, double-click 
on the rectangle object to open its properties. Select the thickness you 
want and click the Finish button. 

6. To edit the drawing object, double-click the line or rectangle to open the 
dialog box with its properties. 
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The label should show the following: 

 
Label with fixed objects 

Use Alignment Tools 

You have placed the objects on the label. Now you want to make sure they are 
aligned on the horizontal center of the label. You can align objects on the label 
by using the Align toolbar on the right side of the working window. 

To align objects on the label, do the following: 

1. Select all objects on the label. 

Note: The first object you select determines the alignment orientation for 
all selected objects. 

2. Choose a select arrow in the Toolbox and draw a frame around all 
objects to select all objects. 

Drag 
object 
handles to 
change 
object size. 
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Selecting the objects on the label 

3. In the Align toolbar on the right, click the  button to arrange the 
objects. 
The selected objects are rearranged and positioned on the horizontal 
center on the label. 

Note: There are also other alignment commands available in the Align 
Toolbar. 

 

Note: You can also align the objects to the label grid. The option Snap to 
Grid is available in the View menu. 

Save a Label 

Always save your label during the design process.  

To save a label, do the following:  

1. Select the  button. 

2. Type in the name of the label. For example, type label for the name of 
the label. 

3. The name of the label is visible in the program caption. 



Chapter 3: Label Design and Printing  

 

 

22 ZebraDesigner Pro Quick Start Guide 

 
Name of the label in the program caption 

Preview and Print a Label 

If you want to print a label, you can use the print preview to simulate a print 
output. The label preview shows the label on the screen. 

Simulate printing 10 labels on the screen to check label layout and printing 
procedure. 

1. Click the   button in the Standard Toolbar or select the 
command Print in the File menu. The Print dialog box appears. 

 
Print / print preview dialog box 

2. Enter 10 for Label Quantity and click the Preview button. 
ZebraDesigner Pro closes the dialog box and simulate the production 
for 10 labels on the screen. 

Note: You can select between the quantity of the labels and the quantity of 
the pages. The page can have one or more labels and the labels are 
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arranged on the page in columns and rows. If you have eight labels 
on the page, the quantity of ten pages prints 80 labels. 

When you are certain that the labels will be printed correctly and the preview 
shows the correct values, you can proceed to real printing.  

To actually print the labels, do the following: 

1. Click the  button in the Standard toolbar.  
The Print dialog box appears. 

2. Enter 10 for the Label Quantity and click the Print button.  
Your printer will now print 10 labels. 

3.1.2 Add Variable Fields to a Label 

You may want to print a label on which the data changes for each label. 
ZebraDesigner Pro offers different variable fields (counters, date/time fields, 
operator's input from the keyboard) that you can use with text, graphics, and 
bar code objects. 

For this example a new label was created. The following steps explain how to 
create a label that contains a prompted field, a counter, and date/time fields. 
The captions in the following screenshots were added separately. 

 
The left label shows design mode, the two right labels are two consecutive labels from print preview 

Create Keyboard Entry Variable Fields 

The content of a prompted field can be different for every print job. Before 
you print the label, you enter the value for the field. 
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1. Click the small arrow next to the  button in the Toolbox to 
display a list of available variable types. 

2. Select New Keyboard Input from the list and click the label where you 
want to position the object. 
A dialog box with the Variable Wizard opens. 

 
Creating new keyboard input variable field 

3. Type Enter product name for the option Display this text to the print 
operator. 

4. Click the Finish button.  
The cursor changes its shape to an arrow with a text object.  

5. Click on the label where you want to position the prompted field. 
The text object is placed on the label and linked to the new variable. 

Note: When you print the label, you will be prompted to type the product 
name, which will be shown in preview on the label and on the 
printed label. 

Create Serialized Data Variable Fields 

Now create a counter field on the label. The value of that variable field 
automatically increases by one on every label. 

1. Click the small arrow next to the  button in the Toolbox to 
display a list of available variable types. 
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2. Select New Counter from the list. 
A dialog box with counter properties opens: 

 
Creating new counter variable field 

3. Leave everything as default so that the counter always starts from one 
and increase by one on each label.  

4. Click the Finish button. 

5. Click the label where the counter should be placed. 
The new variable is linked to the text object on the label. 

Note: Typically, the counter increases by one on each label. For example: 
1, 2, 3, 4, 5, et cetera. You can also define different incremental 
steps. 

Create Date and Time Variable Fields 

Content of the variable field can be filled automatically with the date or time 
stamp from the computer clock or printer clock (for supported printer models). 

1. Click the small arrow next to the  button in the Toolbox to 
display a list of available variable types. 

2. Select New Date Field from the list.  
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A dialog box with date properties opens. 

 
Creating new date variable field 

3. Leave everything as default and the date will be used on the label using 
the format as defined in your Windows operating system. 

To place a time stamp on the label, do the following: 

1. Click the small arrow next to the  button in the Toolbox to 
display a list of available variable types. 

2. Select New Time Field from the list.  

3. Click the Finish button. 

4. Click on the label where the time or date field should be placed. 

The new variable is linked to the text object on the label. 

The date and time fields are updated when you preview or print the label. In 
this example, the values will come from the system clock of your computer. 

Use Prefix or Suffix Options 

You can add a prefix and suffix to each variable field on the label. Both are 
added to the value when you preview and print the label. 

1. Click the small arrow next to the  button in the Toolbox to 
display a list of available variable types. 

2. Select New Keyboard Input from the list.  
A dialog box with variable properties will open. 
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3. Type the text Enter product weight for the option Display this text to the 
print operator.  

4. Set the allowable characters to digits and click the Next button. 

5. Enter kg for the Suffix option. 

 
Defining the variable suffix 

6. Click the Finish button. 

7. Click the label where you want to position the prompted field. 
The text object is placed on the label and linked to the new variable. 
When you will preview or print the label, the suffix kg will be appended 
to the entered value on the right side. 

3.1.3 Change Common Printer Settings 

When you start designing a label, you tell ZebraDesigner what printer the 
label will be associated with. Each label file remembers the printer settings for 
the selected printer driver on the label. 

As an example, you will change the printing speed and darkness.  

To change the printer settings, do the following: 

1. Go to File > Printer Settings.  
The window with the printer settings will open. 

2. Open the Options tab. 

3. Change the Speed and Darkness options.  

4. Click the OK button. 

5. Save the label by clicking the  button in the Standard toolbar, or 
selecting the command Save in the File menu. 
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Printer driver properties 

Note: Any changes in the printer settings dialog box will be saved to the 
label and applied to future print actions. 

You can also change the printer settings right before the label is printed. 

1. Select File > Print. 

2. Go to the Printer tab. 
This tab allows you to change the printer just before printing begins, but 
it also enables you to change common printer settings like speed, 
darkness and print direction. 

Note: Changes to the settings in the Printer tab will not be saved in the 
label but used only at print time. 

3.2 Linking a Label to Text Databases 
Text databases are text files containing data values that can be used for 
variable objects on the label. The text database is not a real database. It 
contains the data values, but lacks the information of the data structure, name 
of the fields, and maximum lengths of the fields. You have to provide the 
missing information before ZebraDesigner Pro can use the data from such a 
text database.   

3.2.1 Connect to a Database 

ZebraDesigner Pro offers a Database Wizard that guides you through the 
necessary steps to connect the database to a label.  



 Chapter 3: Label Design and Printing 

 

 

ZebraDesigner Pro Quick Start Guide 29 

To connect your label to a database using the Database Wizard, do the 
following: 

1. Click the  button in the Standard Toolbar. 

2. Click the Browse button and point to the text database SAMPLE.TXT 
in the Samples folder.  

 
Selecting the text database 

3. Click the Next button. 

Note: If you connect to the database for the first time, you need to define 
the database structure. Continue with the next section. 

3.2.2 Format the Data with the Text File Wizard 

Because the text files do not contain the structural information that databases 
do, you must define the fields and their data structure. When you use the same 
text database again, you won't have to define the structure again. 
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1. Choose the data type for the selected text database. The fields are 
aligned in columns, so you must select the option Fixed.  

 
Defining the type of the text database 

2. Click the Next button. 

3. Define the widths of the individual columns by placing a break line 
before the second column and before the third column. 
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Defining the fields in the text database 

4. Click the Next button. 

5. Accept the default field names, and click the Next button. 
Review the text database structure. The field names and their maximum 
lengths are displayed.  

6. Click the Finish button to close Text File Wizard. 

The link to the database has been created and database fields are available 
on the label.  

ZebraDesigner brings you back to the Database Wizard. 

3.2.3 Place Database Fields on a Label 

The next step in the Database Wizard opens the dialog box with the list of 
available fields from the database.  

By default, all fields from the database will be used on the label.  

1. Click the Next button. 
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Using all fields in the text database 

2. Specify what records and how many you want to print: 
 
Select the options I want to select which record to print and I will 
enter label quantity for each selected record. Before printing labels, 
the table with the records will open and you will be able to select the 
records you want to print and the quantity of labels for each record. 

 
Specifying which records from the database will be printed and in what quantity 

3. Click the Next button. 

4. Select if the Database Wizard should link all selected fields from the 
database to the text objects on the label, or if you want to link the fields 
manually to the label.  

5. Click the Next button.  

6. Select I want a text object for each selected field, and click the Finish 
button. 
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Each field from the database will be linked to a text object 

The label will show several text objects. Every field from the database is 
linked with the text object on the label.  

3.2.4 Use Print Preview to Select Data and View a Label 

Now you will simulate label printing using print preview: 

1. Click the print  button in the Standard Toolbar. 

2. The Print dialog box opens with the Quantity of labels set to Variable 
quantity (entered for each database record). This setting corresponds 
to your selection in the Database Wizard when you have selected the 
options I want to select which record to print and I will enter label 
quantity for each selected record. 
 
Only the records you select will be printed in the defined quantity. 

 
Print / Print preview dialog box 

3. To choose which records to print from the database, click the Select 
Records button.  
The Record Selection dialog box will open. 

4. Select the records from the database you want to print and enter the 
number of labels you want to print for each selected record. 
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Selecting records and specifying label quantity 

5. Click the OK button.  
You will return to the Print dialog box. 

6. Click the Preview button. Now you can preview the labels on the 
screen. Note that the text objects on the label change for each new 
record. 

 
Preview of the first label in the series 

7. Click the Next button in the command window to advance to the next 
label in the series. After you see the last label in the preview series, 
ZebraDesigner will re-open the Print dialog box. 

8. Click the Close button to close the Print dialog box. 

3.2.5 Print a Label 

When you are certain that the label design is correct and label preview shows 
the correct values from the database, you can start sending the labels to the 
printer.  
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To print a label, do the following: 

1. Click the  button in the Standard Toolbar. 
The Print dialog box will open (same as the Print Preview dialog box). 

2. Click the Select Records button, and select the records you want to 
print and specify the label quantity for each record.  

 
Selecting records and specifying label quantity 

3. Click the OK button. 

4. Click the Print button to start printing labels. 

5. Click the Close button to close the dialog box. 

3.3 Designing an Advanced Label 
In this section, you will learn how to design a label with advanced features. 
You will learn how to create a label using: 

a. EAN.UCC 128 bar code. 

b. Links to advanced databases.  

c. Advanced objects and functions. 
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3.3.1 Create a Label with EAN.UCC 128 Compliance 

EAN.UCC 128 compliant bar codes are often used for encoding data into the 
bar code. ZebraDesigner Pro provides an EAN.UCC 128 Bar Code Wizard 
that helps you merge the data components (Application Identifiers) into the 
final bar code. 

Edit Bar Code EAN.UCC 128 

 
The designed label with EAN.UCC 128 bar code 

To define the EAN.UCC 128 bar code, you first select this bar code type and 
assign a value to it. 

1. Click the small arrow button next to the  button in the 
Toolbox. 

2. Select Fixed Bar Code in the Context menu. 

3.  

 
Creating a fixed bar code 

4. Move the cursor to the location on the label where you want to place the 
text object, and click the mouse button.  
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The wizard with object properties will open. 

5. Click the Define button.  
The Edit Bar Code dialog box will open. 

6. Expand the group EAN.UPC, and select the bar code EAN.UCC 128. 

7. Click OK button to go back to the Bar Code dialog box. 

8. Click the Next button. 
The EAN.UCC 128 Wizard will open. 

Add Content to EAN.UCC 128 Using EAN.UCC 128 Wizard 

Use the EAN.UCC 128 Wizard to help you add the necessary Application 
Identifiers (AI) in the bar code.  

To add content to EAN.UCC 128 using EAN.UCC 128 Wizard, do the 
following: 

1. Select 10 Batch or Lot number.  
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Selecting Application Identifier from the list 

2. Click the Next button. 

3. Select Fixed, and click the Next button. 

4. Enter the sample data, for example 12345. 

5. Click the Next button.  
A dialog box showing all AI contained in this bar code will open. 

6. Click the Add button to start adding a new AI. 
For example, select AI 21 (Serial Number). Repeat steps from 1 to 5 
above. 
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Two Application Identifiers are defined 

7. When you are satisfied with the designed AI and their positions within 
the bar code, click the Finish button. 
The EAN.UCC 128 bar code is placed on the label. 

3.3.2 Link a Label to Advanced Databases 

The options described in this chapter are only available in ZebraDesigner Pro 
edition. 

You can use ZebraDesigner to retrieve data from any database on your 
computer or network. If you have the appropriate database drivers, you can 
connect to the database and use the records on the label. 

Note: ZebraDesigner does not have the database options available. You 
cannot link to the databases. 
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With ZebraDesigner Pro you can connect to any ODBC database type as long 
as you have the appropriate database drivers installed and configured on your 
computer. 

You have total control over which records in the database table will be 
printed. By default, all records are printed, but you also have the option to 
select the records for printing. Before the labels are processed, you can select 
the records in the table that you want to print. You can also specify the print 
quantity for each record. 

3.3.3 Using Advanced Objects and Data Manipulation 

Use Linked Fields 

Select the linked field to merge the contents of selected variable fields into 
one field. The selected input variable fields are combined values and used as 
the value for the current object. 

To merge some variable fields together in a text object on the label, do the 
following: 

1. Click the  button in the Toolbox. 

2. Click the label where you want the new text object positioned. 
Text Wizard will start. 

3. Select the option Variable Text. 

4. Click Next button. 

5. For the type of the variable field, select the option Linked Field. 
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6. Click Next button. 
The Linked Element dialog opens. 

 
Linking fields together 

7. Select the variable objects from the combo box, and click the Add 
button to merge them together. 
The selected fields are visible in the Selected elements section. 

8. Select the separator between the fields in the merged content (optional). 

9. Click the Finish button. 
The new text object with merged values of the input variable fields is 
placed on the label. 

Use RF Tag Unique ID 

Printers with RFID functionality can program RF tags embedded in the labels. 
Each RF tag has stored a unique ID number that was programmed into the tag 
during the manufacturing process. The unique number cannot be altered, but 
the RFID-enabled printer can read it. 
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To use the RF Tag Unique ID on the label, do the following: 

1. Click the  button in the Toolbox. 

2. Click the label where you want the new text object positioned. 
Text Wizard will start. 

3. Click the Select button and select one of the internal printer fonts for 
this text object. 
You cannot use text objects formatted in a TrueType font with RF Tag 
Unique ID. 

Note: If you are using RF Tag Unique ID with the bar code object, make 
sure the bar code is printed as internal printer object and not as a 
picture. 

4. Select the option Variable Text. 

5. Click Next button. 

6. For the type of the variable field select the option RF Tag Unique ID. 
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7. Click the Next button. 
The RF Tag Unique ID step opens. 

 
Using the RF Tag Unique ID on the label 

8. Select the type of RF tag you have embedded in the labels.  
Only the RF tags that are supported by the current printer are shown in 
the list. 

9. Enter the preview of the RF Tag Unique ID data in the Preview 
(WYSIWYG only) field. 

Note: ZebraDesigner Pro does not obtain the RF Tag Unique ID from the 
printer, so the real data cannot be previewed on-screen; the real data 
can only be printed with the object. Enter the data in the Preview 
(WYSIWYG only) field for designing / previewing purposes. 

10. Click the Finish button. 
The new text object linked with RF Tag Unique ID is placed on the 
label. 
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Use Visual Basic Expression 

Visual Basic expression allows you to to manipulate your variable fields with 
the power of Visual Basic functions. The result of the expression will be used 
with the current object on the label. You can define one-line expressions that 
must follow Visual Basic programming syntax. 

To use Visual Basic expression to work with the data values on the label, do 
the following: 

1. Click the  button in the Toolbox. 

2. Click the label where you want the new text object positioned. 
Text Wizard will start. 

3. Select the option Variable Text. 

4. Click the Next button. 

5. For the type of the variable field select the option Visual Basic 
expression. 

6. Click the Next button. 
The Visual Basic expression step opens. 
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Using the RF Tag Unique ID on the label 

7. Enter your expression in the field Expression.  
For example: type 1 + 4*20. The result is 81 and it will be used as the 
value for the current text object. 

Note: You can also use other variable fields in the Visual Basic 
expression. Make sure to enclose the names of the variable fields in 
the square brackets like this:  
[My variable field1] or [My text1]. 

8. Click the Finish button. 
The new text object with value as result of the Visual Basic expression 
placed on the label. 

Note: For more information about ZebraDesigner Pro advanced features, 
please refer to the User Guide or help file. 

3.4 Designing an RFID Smart Label 
Radio frequency identification (RFID) refers to technologies that use radio 
waves to automatically identify individual or groups of items. ZebraDesigner 
and ZebraDesigner Pro printer drivers support programming and printing of 
RFID tags embedded in a label.  

Note: You can use RFID functionality in ZebraDesigner Pro only if you 
have installed and selected a ZebraDesigner printer driver with 
RFID support. 

3.4.1 Create RFID Smart Label 

1. Click  button in the Standard toolbar.  
Label Setup Wizard will start. 

2. Select the printer that supports RFID smart label printing.  

3. Click the Finish button. 
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You will see that RF Tag command is enabled in the Toolbox on the 
left side of the ZebraDesigner software Design window. 

 
RF Tag is available for use 
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3.4.2 Encode RF Tag 

The RF tags embedded into the label are usually these types:  

• ISO tags—encode blocks of data 

• UHF tags — encode one string of data. 

1. Click the  button in the Toolbox to begin encoding the 
data.  
The RF Tag dialog box opens. 

 
Encoding contents for RF Tag 

2. Select the type of the RF tag you want to use from the list box on the 
top of the dialog box. 

3. Select the option Use RF Tag in label.  

Note: If you don’t select the Use RF Tag in label option, the definition of 
tag content is saved, but not sent to the printer. 
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4. Go to the first available block in the section Data Blocks and click the 
Data cell in the table.  

5. Type in the value you want to encode into this block.  
Repeat the process for other blocks. 

6. Click the OK button.  
A schematic view of the RFID tag antenna will open in the label 
background identifying the definition of the RFID data on the label. 

 
RFID Tag antenna in the background 

7. You can continue designing the smart label with non-RFID data as 
described in the previous sections. 

When you print the label, the RFID data will be sent to the printer. The printer 
prints the RFID smart label and programs the RFID tag embedded into the 
label at the same. 

Note: ZebraDesigner Pro can work with unique RF tag numbers. Each 
RFID tag has embedded a unique serial number. Some printers can 
read the unique RF tag number and it can be used on the label linked 
with some label objects. 
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3.5 Storing Fonts to the Printer 
ZebraDesigner Pro provides fast and reliable label printing to thermal printers 
using the ZebraDesigner Pro printer drivers that are optimized Windows 
thermal printer drivers. ZebraDesigner Pro printer drivers support printer 
hardware accessories like cutters and different label sensors, but also printer 
resident objects. Such objects are fonts and bar codes that are built into the 
printer. Printers always print labels that use resident objects very quickly 
because the driver generates a print file with references to the objects already 
stored in the printer's firmware. The print file is short and can be transferred 
quickly to the printer. 

When you print labels with graphic and non-resident objects, all unsupported 
objects are converted to pictures and sent to the printer as graphics. This 
approach ensures that the label is successfully printed on every printer. But the 
printout speed varies on different printers, depending on the number of objects 
that are recognized internally by the printer. 

The solution for fast printing is available with the memory card manager Font 
Downloader that enables you to store Windows fonts (TrueType, OpenType, 
Type 1, and other) on the printer. 

Fonts can be downloaded to the printer’s internal memory or add-on memory 
cards. The number of objects that can be downloaded is limited only by the 
memory size. 

Once the objects are stored in the printer, you do not have to send them to the 
printer again. The objects are recalled from the printer memory, ensuring fast 
response at print time. Other applications can also take advantage of the 
downloaded objects and print labels quickly. 

The content of one memory card can be used on many labels. 
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4. Technical Support 

If you experience any technical difficulties using the ZebraDesigner software, 
the first thing to do is to refer to the on-line help and User Guides available on 
the ZebraDesigner Pro CD. 

4.1 Online Support 
You can find the latest builds, updates, workarounds, for problems and 
Frequently Asked Questions (FAQ) under the Support section on the Zebra 
Web site. If you cannot solve the problem on your own, please contact your 
local vendor or representative offices. 

 

4.2 Contact Information 
Worldwide, Technical Support is available through your Reseller, or at: 
http://www.zebra.com/id/zebra/na/en/index/service_support.html. 

http://www.zebra.com/ support 

 

Zebra Technologies Corporation 
International Headquarters 
333 Corporate Woods Parkway 
Vernon Hills, Illinois 60061-3109 USA 

Phone: +1 847 913 2259 
Fax: +1 847 913 2578 
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